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Parte 1
TERRENOS

Un terreno representa el suelo
sobre el que se moveran nuestros
personajes. Aprenderemos como
crearlos dentro de Unity




TERRAIN TOOLS

Aunque existen programas para crearlos externamente (como Houdini o WorldMachine), Unity tiene una herramienta
para generarlos internamente como un Game Object especial: GameObject ->3D Object -> Terrain.

Al crear un terreno, se generara
en la escena un plano de grandes
dimensiones, y en nuestro proyecto
un archivo con los datos de
configuracion del terreno.

‘
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Si seleccionamos el terreno, veremos en el
inspector que tiene opciones especificas de los
terrenos (como un colisionador de tipo Terrain
Collider). En el componente “terrain’, organizadas
por pestanas, tendremos las siguientes opciones
para modelar y configurar el terreno, las cuales
veremos mas adelante:

. z
s ¥ Terrain

m v Terrain Collider

Material None (Physic Material)

Crear un terreno adyacente

Pintar el terreno: anadir
elevaciones

capas Yy crear

Anadir arboles y detalles

Configuracion, veremos las opciones basicas
del terreno: detalle, sombras, distancia a la
que se ven los arboles, viento, etc.

Aqui puedes ver todas las opciones

Terrain tools

Existe un paquete que facilita la creacion vy
gestion de los terrenos, aunque no es -a dia de
hoy- un paquete oficial. Por ello, si queremos
instalarlo tendremos que activar la visualizacion
de paquetes que estan en desarrollo. En “Edit >
Project Settings > Package Manager” veremos
la casilla donde podemos activar los paquetes
en desarrollo (Enable Preview Packages), que
debemos activar con cuidado tal y como nos
advierte.

arly stages of developm

recommend using these only for testing

Una vez activada, podemos buscar el paquete
Terrain Toolbox en la ventana de Package
Manager > Unity Registry:

Terrain Tools

Unity Technologies

Version 3.0.2-preview.3 - November 09, 2020

ditonal terrain scul
tunning terrain ass

Una vez instalada, tendremos la opcion en el
menu de Window > Terrain > Terrain Toolbox, que
nos permitira crear terrenos nuevos (los creara
dentro de un grupo de terrenos) o editar los que
ya estan creados a traves de un panel propio.

NOTA: Una buena opcion es descargar ejemplos

de terrenos con herramientas adicionales en la

Asset Store:
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ANADIENDO TERRENOS A LA ESCENA

Usar el paquete "Terrain ToolBox" para crear
terrenos nos permite configurar sus dimensiones,
Su posicion, o la carpeta en la que se guardaran
los datos vinculados al terreno. Cuando Lo
tenemos todo listo, pulsamos en "CREATE" y se
anadira el terreno y un Empty Object Padre en la
escena, para agrupar los terrenos colindantes.

Terrain Toolbox a i

ew Terrain Terrain Settings Terrain Utilities Terrain Visualization

Import Heightmap
Gizmo

Preset BNone (T@ Save SaveAs Refresh

Options

errain/

Group ID: 0

Numt

Create

Un dato importante es el "Grouping ID", ya que es
lo que garantiza que dos terrenos estan “unidos”.
Para anadirlos, es preferible usar la herramienta
de expandir terrenos colindantes que veremos
mas adelante.
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Mapa de alturas

Podemos crear terrenos
a partir de imagenes
bidimensionales, los
llamados mapas de
altura (height maps).

Unity convertira las partes
luminosas de la imagen en zonas

elevadas, y las partes oscuras en zonas bajas del —

terreno.

Si activamos la casilla ‘Import Heightmap" del

las diferencias de alturas. Por eso se
recomienda usar archivos RAW de 16 bits
por canal (Photoshop permite guardar
a2 como “Photoshop RAW', en formato PC).
Si el archivo no tiene calidad suficiente,
es posible que salgan cambios bruscos
de altura en forma de terrazas. Podemos
evitarlo bajando la resolucion de
importacion (Tile Height Resolution).

Terrain ToolBox podremos usar una imagen en .

blanco y negro para crear el mapa.

v Import Heightmap

Global Batch Tiles

513

None

En la opcion de "Height Remap” podemos indicar
la altura que tendran las zonas blancas y la que
tendran las negras.

NOTA: cuanta mas informacion tenga la imagen
en su escala de grises, mejor interpretara

También podemos importar

un mapa de
alturas en un terreno ya creado, en la pestana
de configuracion del terreno, buscaremos el
apartado de Texture Resolutions, y pincharemos
en el boton de ‘Import Raw”

Texture Resolutions (On Terrain Data)

Q-

Heightmap Resolution 513x513 -

Import Raw..
512x 512 A
1024 x 1024 v

Export Raw...

Existe también la opcion de exportar un mapa
de altura de un terreno que hayamos creado
nosotros, por lo que podremos reproducirlo en
otro terreno.
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Fill Heightr

EXTENDER EL TERRENO

== ¥ Terrain

Vamos a ver las diferentes opciones (pestanas) que aparecen en el inspector cuando seleccionamos un terreno.

La primera opcién que nos encontramos en Sitenemos marcada la casilla de “Fill Heightmap [

las pestanas del componente “Terrain” es la de

anadir terrenos colindantes.

Mirror

Al activarla, nos mostrara en la escena los 4 lados
de nuestro terreno a los que podemos anadir
uno nuevo. Si hacemos click en cualquiera de
esos cuatro cuadrados senalados, aparecera
automaticamente un terreno nuevo.

Using Neighbors', el terreno colindante tomara
las elevaciones del borde para continuarlas de
dos maneras:

1. Enla opcion de “‘clamp’ las ira suavizando

2. En la opcion de “mirror” creara un duplicado
que tendera a aplanarse

Si activamos la casilla de "Auto-conect’ en
terrenos que estan en el mismo ID, en la pestana
de configuracion del terreno, al modificar uno en
la zona de contacto se modifica el otro.

Si queremos que se comporten como un solo
terreno, deben compartir el mismo ID, que se
encuentra en la configuracion del terreno, en
‘Grouping ID". Ademas, deberan tener la misma
resolucion

Antes de seguir: configurando los parametros

de los pinceles (fuerza, tamano, rotacion

espaciado y dispersion) obtendremos el
resultado deseado. Pulsa la tecla y desplaza
el raton a izquierda y derecha para ajustarlos
(tambien puedes importar tus propios pinceles

en “New Brush e importando una imagen):

A" ajustar la fuerza del pincel .
*S" ajustar tamafio del pincel.

‘D" ajustar rotacion.

‘Ctrl" invierte el efecto del pincel.

*Shift’ activa la herramienta de suavizado.
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ESCULPIR EL TERRENO

En la pestana de pinceles tenemos varias opciones para modificar la orografia del terreno trabajando con pinceles.

Veamos ahora diferentes herramientas

disponibles para esculpir el terreno:

Seulpt
Effects
Erosion
Mesh Stamp

Raise or Lower Terrain

Stamp Terrain

Raise or Lower Terrain

Crea elevaciones en el E&
terreno. Como todas las
herramientas, si pulsamos
Ctrl se invierte la funcion
(en lugar de elevar, hunde
el terreno).

Set height

Ajustando la altura (height) [
del pincel, pondremos una
altura homogénea a toda la
zona del terreno.

Smooth Height

Suaviza las irregularidades del terreno. Una
herramienta muy habitual, por lo que se accede
tambien pulsando la tecla “shift’” Como todas, es
bueno ajustar una fuerza adecuada

7

Stamp Terrain

Configurando la altura, al hacer click se
‘estampara” una vez la forma del terreno que
tengamos configurado en los pinceles. Esto nos
permite configurar nuestros propios pineceles
con formas complejas y anadirlos al terreno de
forma facil.

Sculpt
Permite opciones adicionales:

Noise: agrega ruido al terreno. Se puede
ajustar los parametros de ese ruido

Bridge: seleccionando un punto de inicio al
hacer “Ctrl. + Click" y uno [E '
de final, crea ‘caminos”
con la forma del pincel
seleccionado.

Terrace: divide las alturas
del terreno en “terrazas’

Effects

Permite varias funciones:

aumentar diferencias (contrast), afilar picos
(sharpen peaks), suavizar pendientes (slope
flatten).

Erosion

Simula erosion de tres formas, F
por agua, viento o calor. Tiene
parametros propios bajo la
opcion de “Simulation Scale'

Mesh stamp

Debemos seleccionar una malla de nuestro
proyecto, y ‘estamparla” en nuestro terreno.

Transform

Herramientas precisas para modelar el terreno,
como pinzar, retorcer, difuminar.

Paint holes

Permite abriragujeros en elterreno donde colocar
nuestras propias mallas, por ejemplo, una cueva.
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https://docs.unity3d.com/Manual/terrain-RaiseLowerTerrain.html
https://docs.unity3d.com/Manual/terrain-SetHeight.html
https://docs.unity3d.com/Manual/terrain-SmoothHeight.html

ESCULPIR EL TERRENO (ejemplos)

Rise or lower Terrain Set height Noise

Bridge Terrace Erosion
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ANADIR TEXTURAS

Logicamente, nuestro terreno tiene que tener una textura -o conjunto de texturas- que le den realismo. Para ello se
utiliza la herramienta de “Paint Texture” de la pestana de pinceles.

Para poder aplicar una textura, debemos
anadir al terrenos al menos una capa. Para ello,
seleccionamos en la herramienta de pincel, y en
el menu de ‘capas’ elegimos un nombre para
nuestra capa y pulsamos en “Create” (tambiéen
podemos hacerlo directamente en el proyecto
Create. > Terrain Layer). Si ya tenemos capas
creadas, podemos anadirlas en "Add Layer".

) to paint on the terra

B None (Terrain Pale @

Save SaveAs Refresh

Add Layer Remove Layer Remove Selected Layers

Create New Layer NewLayer Create...

Layer Properties

Nos pedira asignar una imagen que usara como
textura Diffuse. Al ser la primera capa, la tomara
como la textura base del terreno:

Podemos ir anadiendo mas capas, creadas por
nosotros o importadas.

Layer Palette

R Hierba

B Csas  capas las
B podemos  editar de
formaindependiente si
las seleccionamos en
el proyecto, anadiendo
mapa de normales o
| incluso de mascara,
ademas de ajustar
ciertos parametros del
| material como si de
| Una textura cualquiera
se tratara.

La combinacion de mapas y parametros de la
textura determinara su realismo.

Cuando“pintamos”sobreunacapa, determinamos
las zonas que se ven de esa textura. EL n° de
capas maximo recomendado esta entre 4 y 8,
dependiendo del método de compilacion.
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ANADIR DETALLES: ARBOLES

Una vez “pintado” con texturas nuestro terreno, es el momento de anadir algunos detalles para darle realismo.

En los terrenos se pueden “pintar” arboles igual
que se pintan elevaciones o detalles.

Si vamos a la pestana de “arboles” en nuestro
terreno, antes de comenzar a pintar debemos
anadir un tipo de arbol (Edit Trees > Add Tree):

= v Terrain

Paint Trees

No trees defined

Add Tree i)
Settings Edit Tree
Brush Size Remove Tree  [B

ree

Random? +

Tree Height

Lock W v

En la ventana que se abre de ‘Add Tree"
deberemos buscar el arbol en la casilla de Tree
Prefab y pulsar en ‘Add’, ya que los arboles son
un tipo especifico de prefabs.

Los arboles podemos editarlos de forma
independiente atravesde suventanadeinspector,
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en el proyecto.
Veras que tiene
un gran numero
de opciones
vinculadosalprefab
que contiene el
arbol.

Ahora, ajustando el tamano del pincel, y la
densidad de arboles, podemos anadir el tipo
de arbol seleccionado. Podemos ajustar otros
parametros como la aleatoriedad de la altura, el
giro o el color:

TRUCO: Para borrar arboles se pintara pulsando
la tecla “shift" (anadiendo “Ctrl" si solo queremos
borrar los arboles del tipo seleccionado).

Una opcion es la de anadir arboles de una vez
a todo el terreno mediante el boton "Mass Place
Trees"

Si queremos que los arboles no puedan
atravesarse, debemos activar ‘Enable Tree
Collider" en el componente “Terrain Collider” del
terreno.

Una alternativa es crear tus propios arboles. Unity
permite hacerlo de dos maneras:

1. Usando la herramienta de "Speed Tree", un
software de terceros disponible para PC y
para MAC

2. Mediante el "Tree Editor’, que partiendo desde
un tronco sencillo (Game Object > 3D Object
> Tree) podemos ir anadiendo elementos de
forma nodal. Este metodo no soporta LOD's.

Unity cueta con escenas completas de terrenos
que puedes descargar gratuitamente. Eso si,
estan realizadas para Universl Render Pipeline
y para High Definition Render Pipeline (que los
veremos mas adelante). Pero puedes descargar
los paquetes (cuidado que pesan bastante) e
importar solo lo que desees:
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https://docs.unity3d.com/Manual/terrain-Trees.html
https://assetstore.unity.com/packages/3d/environments/unity-terrain-urp-demo-scene-213197
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ANADIR OTROS DETALLES

Hierba Rocas y detalles

En la ultima pestana de edicion de terrenos [kl ' . B Para anadir detalles como rocas, el
nos permite anadir elementos pequenos, [EEEEE “ proceso es el mismo, seleccionando "‘Add & 2 None (Game Object
como rocas o hierba, que doten de mayor Detail Mesh’, pero en lugar de texturas
realismo a nuestra escena deberemos elegir prefabs.

Para anadir hierba deberemos pulsar en "Edit | e Adicionalmente, en la ventana para anadir
Details" y "Add Grass Texture”. el elemento, nos aparecera la opcion de
Vertex Lit
, N o ~ Render Mode (en lugar de la opcion de EEEE Y Grass
A continuacion, nos pedira que anadamos alguna textura. . . ' g a detail prefab

BillBoard), con dos opciones:

Podemos encontrar tanto texturas de hierba como de detalles en la Asset
Store de unity.

1. Grass: renderiza el elemento de una
forma similar a la hierba, como una

1 Antes de anadirla, podemos configurar algunos textura bidimensional.

parametros como color. tamano, etc 2. Vertex Lit: renderizara el detalle

como un objeto 3D. Mas apropiado para
elementos como rocas.

B o activamos la casilla de "Billboard" nos aseguramos

_ de que siempre esté mirando a cdmara.

Ahora solo tenemos que ajustar los parametros del
pincely pintar estos detalles por el terreno:
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UNA PUNTE SOBRE LOS LOD'’s

En la siguiente imagen veras un ejemplo muy basico de una esfera que cuando se ve de lejos
no es mas que un cubo de 6 lados y 24 vertices (no necesita mas detalle) pero cuando se

Como posiblemente sepas, cuando se -
acerca pasa a ser una esfera de 1500 vertices:

modela un objeto para un videojuego,
se suele hacer con varias resoluciones
para que el motor de videojuegos
pueda intercalar entre las mallas de
menor numero de vertices cuando
esta lejos y las que tienen mas detalle
cuando la camara esta cerca. Esto
garantiza un mayor rendimiento.

0 BolaLOD

Son los llamados ‘Levels of Detail’
(LODs), y Unity cuenta con una
herramienta para configurarlos.

Si quieres comprobarlo, anade a una
escena un Empty Object y pon como
hijos las diferentes mallas con niveles de
detalle. Incorporando el componente
‘LOD Group" podras configurar a que
distancia ‘cambia” de malla, y qué
mallas se ven en cada grupo.

Recalculate Lightmap Scale
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Controlando un
personaje 3D

Vamos a seguir ampliando
nuestros  conocimientos  del
Animator Controller, y para ello
controlaremos un personaje 3D.




IMPORTANDO UN PERSONAJE 3D

Aunque Unity incluye algunos paquetes que permiten riggear y animar elementos dentro del programa, lo normal es
traerlo ya con las animaciones creadas en programas especificos para ello. Lo mas estandar: importar un FBX

Una vez hemos creado nuestro personaje 3D,
riggeado y animado, y hemos exportado esas
animaciones (normalmente a .fbox) es el momento
de imporrarlo a Unity.

Ahora, arrastra el modelo ‘Armature.fbx
directamente al escenario (anade un terreno si
quieres para que quede mas realista):

NOTA: si no te aparecen las

Para estas practicas,
usaremos el personaje
3D que tenemos
disponible en los
Assets de Unity.

<o ffoxturas, quizas tengas que
leditar los materiales que vienen
-« fen el paquete y anadirselos
=== manualmente, o crear unos
“jhuevos,

Importaremos solo lo necesario: dentro de la
carpeta “Third Person Controller" encontraremos
las animaciones vy el
modelo, y opcionalmente
™ l0s materiales, las texturas,
@l l0s v los sonidos. Cuidado
= porgue algunos elementos
tienen dependencias con
otros paquetes vy entre
ellos, asi como avisos de
compatibilidad. Consulta la
documentacion del asset
para mas informacion.

s - Third Pers: haracter Controller

Al importar el FBX al proyecto, veras RS>
que tiene un icono especifico: H'

Como sabras, los archivos .fbx son contenedores
capaces de albergar multiples mallas, a
menudo organizadas de forma jerarquica,
esqueletos, materiales |
e incluso animaciones,
Funcionan de una
forma similar a un
prefab en Unity.

Sidespliegas el FBX en
le ventana de jerarquia,
veras todas las mallas
y SUs jerarquias:

Puedes anadir objetos hijos (por ejemplo, un
arma en la mano), pero no puedes cambiar esa
jerarquia, ni borrar mallas, pero como cualquier
otro prefab, puedes pulsar con el boton derecho
al FBX en la jerarquia y marcar Prefab > Umpack
Completely y dejara de ser dependiente del fbx
original.

Si despliegas el FBX importado al proyecto, veras
que contiene una malla y un Avatar:

NOTA: un fbx puede contener multiples mallas,
asi como multiples materiales, todos contenidos
en el FBX Aqui se muestra un gjemplo de FBX
que contiene dos mallas y dos materiales:
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IMPORTANDO UN FBX (parte 1)

Recuerda que todos los elementos del FBX pueden configurarse en la importacion, afectando de esa maneraa c’omo

se comportan en la escena.

Si seleccionas el FBX en el proyecto, veras varias
pestanas

Model

Si el modelador se ha equivocado a la hora de
crear las unidades de medida, este es el sitio
para corregirlo, ya sea indicando que el modelo
se hizo en cmts, y no en metros, o escalandolo
en la importacion para no tener que hacerlo en la
escena, algo no recomendable.

g Otras opcionesimportantes
fl son las de desactivar la
importacion  de  luces
o de camaras, por si el
que ha creado el FBX se
ha olvidado quitarlas al
: exportar (dos camaras en
la escena pueden provocar
d fallos inesperados).

Rig

La configuracion del Avatar, es decir, como
debe interpretarse la distribucion de los huesos
de cara a una animacion. Debemos indicar que
tipo de animacion es, que en este caso es de
Humanoide. En cuanto al Avatar, normalmente
viene incrustada en el modelo. Si no es asi, le
podemos decir que lo cree a partir del propio
modelo (generara un Avataren elfbx), oimportarlo
desde otro modelo.

A menudo las animaciones no incluyen un Avatar,
y por tanto no podemos ver como quedara
en el modelo original. En ese caso, le decimos
que lo coga desde otro modelo. Si te fijas, las
animaciones importadas aqui usan el Avatar del
FBX "Armature”

En este caso, el ‘Animation Type" es humanoide.,
Asegurate de que las animaciones que le
apliques mas adelante tienen el mismo Rig, o se
‘desordenara’ el esqueleto alaplicar la animacion.

=

L= U

Open

Model Rig

Animation Materials

Humanoid -
Create From This Model v
~  Configure...

Standard 4 Sones) bl

Sipulsamosen “Configure’seabrirala herramienta
Mecanim de Unity, donde indicamos a que malla
del modelo se corresponde cada hueso, del
cuerpo, la cabeza o las manos. Veremos que cada
hueso tiene su correspondencia en la jerarquia
del objeto en la escena, e incluso podemos
reasignarlos (tendremos que aplicar los cambios)

En la pestana de "Muscles&Settings’ *
puedes ajustar el rango de movimiento g&
de cada hueso.

Sinovas acambiar nada en la jerarquia
del FBX, puedes colapsarlo al activar
la casilla de "Optimize Game Objects’,
mejorando asi el rendimiento.
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IMPORTANDO UN FBX (parte 2)

Animation
Si el FBX contiene animaciones apareceran aqui.

Es en esta ventana donde puedes cambiar su
nombre y sus parametros, como duraciones,
ponerlas en bucle, puntos de entrada y salida,
velocidades, etc.

Como el FBX del modelo no tiene animaciones,
puedes seleccionar las animaciones importadas
para verlo:

Walk_N.anim Imp

Model Rig Animation Materials

16

En la parte inferior,
previsualizador de la animacion, e
moverte por ese entorno 3D. Veras que aparece
un Humanoide estandar, pero si despliegas
el icono del Avatar que aparece en la esquina
superior derecha, y seleccionas “Other’, puedes
hacer que use otro modelo.

puedes desplegar el
incluso

TRUCO: una misma animacion puedes duplicarla
en el proyecto y cambiar sus parametros para
tener dos animaciones distintas, por ejemplo
cambiando sus puntos de inicio y de final.

NOTA: algunas de las animaciones importadas
tienen eventos asociados dentro de la animacion,
tal y como aprendimos en la unidad anterior.
Al ser FBX de solo lectura (@ menos que los
desempaquetemos), no podemos cambiar la
animacion, pero si podemos editar o borrar los
eventos en esta pestana, en el apartado “Events”.
Al seleccionarlos veremos la funcion que llaman
y sus variables, y podemos borrarla. Si te fijas,
son eventos pensados para ejecutar sonidos al

caminar;

Materials
Apareceran los materiales que incluye el FBX.

De nuevo, como no podemos modificar un FBX,
si queremos editar esos materiales deberemos
‘extraerlos’, y una vez fuera del FBX cualquier
cambio que hagamos se aplicaran al original.

Animation Materials

Maodel Rig

IMPORTANTE: cualquier cambio que hagamos
en la configuracion de los parametros de un
FBX importado deben ser guardados al pulsar
en el boton "Apply’, y se aplicaran a todas las
‘instancias” de ese FBX que haya en el juego
(como un prefab).
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ANIMANDO UN PERSONAJE 3D

Sinosfijamos, el personaje Aramture enelescenarioyatiene uncomponente
‘Animator” (sino lo tuviera, se lo podemos anadir), pero no se le ha asignado
ningun "Animator Controller’. Lo haremos nosotros desde cero: en el panel
de proyecto pulsamos Boton Derecho > Create > Animator Controller, le
damos un nombrey se lo asignamos al componente Animator de Armature.

NOTA: entre los materiales importados, dentro de la carpeta de
animaciones, encotraremos un Animator Controller ya creado llamado
‘StarterAssetsThirdPerson”. Aungue podemos usarlo o consultarlo, es
recomendable practicar creando uno desde cero.

> v Animator

ller

Normal
Cull Update Transf

Ahora tenemos un Animator Controller vacio, listo para recibir los hodos
de animacion. Si arrastramos las animaciones importadas al panel del
Animator, las reconocera como nodos nuevos de animacion, y la primera la
asignara como el estado de entrada:

Any State

-ldle.anim
sThirdPerson

Acuérdate de asignar este Animator Controller al componente Animator de
tu personaje en la escena.
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Si ahora lanzamos el juego, veremos que el personaje inicia la animacion
de Idle por defecto.

Prueba a anadir mas animaciones y crear transiciones entre ellas con sus
correspondientes parametros, igual que hicimos en la Unidad Anterior.
Puedes “inspirarte” en el controller incluido en los materiales.

Auto Live Link

Idde Walk Fun Blend

Veras que la transicion entre unas animacionesy otras se crean interpolando
las posiciones de los huesos en base a la duracion establecida en la
transicion. Esto es posible porque las animaciones comparten Avatar, y es
algo imposible de lograr en juegos 2D.

Es el momento de decidir qué animaciones tendra nuestro personaje, y
qué parametros las controlaran, pero antes de hacerlo, conozcamos una
herramienta muy util: el blend tree.

CIFP José Luis Garci


https://docs.unity3d.com/es/530/Manual/class-BlendTree.html

Blend

BLEND TREE

Hemo visto como cada nodo contiene una
animacion independiente, pero existe un tipo de
nodo que permite almacenar varias animaciones
a la vez, creando transiciones entre unay otra en
base alvalor de un parametro. Son los Blend Tree,

Pulsamos con el boton
derecho en el Animator

Controller > Create |
State > From New E
Blend Tree

Create Sub-State Machine
Paste

ULl Copy current StateMachine

Creara un nodo nuevo, que si hacemos doble
click en él lo abrira en un panel nuevo, donde
mostrard un slider que cambia un parametro
float. Si no tenias ningun parmametro float, te
creara uno llamado “Blend’
que sera el que usa, y que
puedes cambiar por otro.

Blend Tree
@

Al seleccionar el nodo creado veremos varias
opciones:

Nombre del nodo. Mejor cambiarlo para
identificarlo mejor.

“‘Blend Type": de momento usaremos un nodo
de 1D (1 dimension), pero debemos saber que
existen Blend Trees de 2 dimensiones donde
se puede controlar el estado del personaje en
base a 2 parametros (los 2 gjes de un joystick)
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‘Parameter” el parametro que gestiona el
estado del nodo. Podemos seleccionar otro
de los creados en nuestro Animator Controller.

‘Motion” en este
panel podemos
anadir "Motion Fields",
cada uno vinculado a

Add Motion Field

Mew Blend Tree

una animacion.

Para ver un ejemplo de un Blend Tree

funcionando, vamos a anadir 3 motion fields, y les
vincularemos con las animaciones disponibles
en los materiales de esta forma: Idle - Walk_N
- Run_N. Para arrastrarlas deberas desplegar el
FBX que las contiene.

Desactiva la casilla de
‘Automate Thresholds”
para poder introducir
tus propios valores,
5 y asi  agjustarlos a
B como quieres que se
comporten o, llegado
el caso, vincularlos a
valores que vayan de
-1a1como en un Axis
de un Joystick. En este
caso, lo llevaremos de
Oal

Sidesplazas la barraroja, o el parametro asociado
(en este caso "Blend") veras como va pasando de
una animacion a otra.

B Junto al parametro de Threshold podras cambiar
¥ la velocidad de ejecucion de la animacion (1 por

defecto) y la posibilidad de hacerla en espejo.

Veras que en el panel
aparecen las animaciones
vinculadas:

Pruebaadaralbotonde “play”enelprevisualizador
de la animacion (en la parte inferior del inspector)
y cambiar el parametro asociado al Blend Tree,
pasandode 0 a1

Para volver al panel normal del Animator
Controller, pulsa en el texto de "Base Layer” que
hay en la parte superior del panel. Veras que
ahora puedes crear transiciones al Blend Tree
como si de otro nodo se tratara.

NOTA: existe otro nodo diferente, que es el Sub-
State Machine, que basicamente nos permite
agrupar una serie de animaciones en un solo
nodo, como un Animator Controller dentro de
otro. Es util para organizar las animaciones en
caso de tener muchos nodos.

CIFP José Luis Garci



ROOT MOTION

Algunas animaciones incluyen desplazamiento,
algo que a menudo no es recomendable (por
ejemplo para desplazarse por un terreno con
desniveles). Para evitarlo, podemos marcar la
casilla "Apply Root Motion" en el componente
Animator de nuestro personaje.

= v Animator

Controller

nply Root Mation

También podemos bloguear las posiciones de
la animacion mediante las opciones “Bake Into
Pose" que contienen en diferentes ejes.

Loop Time

loop match

loop match

1: Body Orientation

loop match @

Original

loop match

Center of Mass
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MIXAMO

La pagina de Mixamo ofrece multples
animaciones que podemos usar en
nuestros proyectos.

Si subimos un modelo, nos permita
buscar y descargarlas en formato fbx
que podremos incorporar a nuestro
controlador de animaciones

Es importante que una vez descargado,
asignemos el tipo de Rigg "‘Humanoid” , si
es necesario, las pongamos en bucle.

Proceso:

1.- Acceder a la pagina web y registrarnos:
https.//www.mixamo.com/

2.- Ir al apartado de Rig->Auto-rigger y
subir nuestro modelo. Requisitos:

Debe estar en obj o .fbx. En fbx
debemos exportarlo con la opcion

€1 mixamo  «

de "embed media”" y el obj con la de
‘materials’

Debe ser un bipedo y estar en posicion
deToA

Debemos subir un ZIP con el OBJ, el
MTL vy las texturas

3- Nos mostrara una pantalla donde
gjustaremos la posicion del modelo (debe
tocar el suelo) y a continuacion ajustar los
puntos clave: barbilla, muneca, codos,
rodillas, ingle

Se recomiendo activar el uso de
simetria.

4.- A continuacion, nos mostrara el
modelo con varias animaciones. Podemos
descargar ya nuestro modelo animado, o ir
a la opcion de "Animate’ para crear alguna
animacion extra (gratuita o de pago).

CIFP José Luis Garci


https://www.mixamo.com/

EJERCICIO

Como ya sabemos vincular
los parametros a entradas
del Input System, asi como
crear transiciones entre
nodos, vamos a disenar
nuestro primer Controlador
de Jugado.

Revisa las animaciones gue tienes disponibles,
decide cuales se gjecutan en un nodo sencillo
y cuales en Blend Tree. Aqui van unas pistas:

Si hemos creado un Blend Tree para
determinar si estamos quietos, caminando o
corriendo, y tienes animaciones para caery
caminar, ‘caery correr"y ‘caer sin mas" (esta
esta dentro del mismo FBX que la de saltar),
lo suyo seria que esas tres estuvieran en su
propio Blend Tree conecado al ya creado.

El paso de saltary estar en el aire, asi como
el de caer y seguir caminando/corriendo,
deberia ser automatico, es decir, sin
condiciones (pero obligando a terminar la
animacion)

Piensa qué parametros necesitaras para
controlarlas y anade las entradas necesarias en
el Input System para controlar esos parametros.
Ejemplo: podemos decidir que el personaje
camina al mover el joystick izquierdo en su
eje "Y' y gira al moverlo en su eje X. No hay
animacion para girar, pero podemos hacerlo
por codigo, por ejemplo:

transform.Rotate(Vector3.up * rotate *
rotationSpeed);

Recuerda que es bueno crear un parametro de
tipo Bool que indica si esta tocando tierra, para
pasar de salto a aterrizaje.

Crea las transiciones y las condiciones.

Es posible que para algunas transiciones
necesites mas de una condicion. Y seactiva la
casilla de “Has Exit Time" donde no se necesite.

Crea un script llamado ‘PlayerController” en
el que vincularas esos valores de entrada
con los parametros del Animator Controller, y
comprueba si controlas bien a tu personaje.

PARANOTA

Puedes buscar en Internet animaciones
adicionales, por ejemplo para desplazamiento
lateral (‘strafe” en inglés). Revisa las
configuraciones de la animacion, quizas tengas
que activar el “Loop Time', el “Loop Pose" y las
opciones de “Bake into Pose" para que no se
desplace.

Existen Blend Tree de 2 dimensiones. Ahora
que tienes control de movimiento lateraly hacia
adelante, ste atreves a gestionarlo todo con un
solo Blend Tree de 2 parametros? ELl primer
parametro gestiona la posicion en X dentro del
eje de coordenadas, y el segundo la posicion
en.

Este seria el aspecto de ese Blend Tree.




